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CCM OVERVIEW

CCM stands for Customer Trust & Partner Support (CTPS) Content Management. This will be used in replacement of
where Selling Partner Content Management (SPCM) has been used in the past within Amazon Selling Partner Support. Teams
include Seller Central, Vendor Central, Standard Operating Procedures (SOP), LTE, Risk Content Management (RCM) and
Brand Registration.

¢ Seller Central is a web site that allows sellers to manage all things including their listing and orders. Sellers list their
nroduct in Seller Central with the nrice thev wish. Thev can either shin their items to Amazon Fulfillment Centers usina
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FBA service, or ship directly to customers from their storage. On the Amazon.XX site, their listing will be shown as
“Ships from and sold by XXX (Seller's name)”. It includes different text types. See below for details.

Vendor Central is a different business where vendors list their items with “cost price to Amazon” and Amazon
purchases their items with their proposed price (cost per unit) at which Amazon issues them Purchase Orders (PO).
Vendors then accept the PO and ship their items to Amazon Fulfillment Centers. Once products are received, they will
be shown as “Ships from and sold by Amazon” (retail order) on Amazon.XX site. Vendor Central has its own specific
termbase.

Brand Registry is a sub-website of Seller Central and Vendor Central. This is for Intellectual Property (i.e. Trademarks)
owner sellers/vendors to register their brands so Amazon can provide more protection to those branded items on
Amazon site. For more context, please refer to https://brandservices.amazon.com/. As a result, they contain sensitive
content. Please be very cautious.

IMPORTANT NOTES

LEGAL SENSITIVE CONTENT

In some of the handoffs emails you receive for this project, you might see a note which reads "LEGAL SENSITIVE" in a
column alongside the other specific handoff information. This note indicates content that is extremely legally sensitive for
Amazon and should be translated and review with extreme care.

By LEGAL SENSITIVE CONTENT we refer to text that cannot have any potentially-misleading wording, terminology, or
implications.

In essence, it means that we need to handle the text in a way that there isn't any possibility for customers who do not speak
any English to misunderstand the content or be confused by it.

As such, please keep the following in mind at ALL TIMES:

This content cannot have any accuracy errors. It is of the utmost importance for Amazon. Any errors in it might bring
legal consequences.

The content has to read naturally, not at all like a literal machine translation. Please make sure the flow is natural and
the file reads normally.

The wording and style has to be consistent with the language rules and conventions.

The Style Guide has to be followed closely. Please download them from this SharePoint and keep it open during
translation/review.

The approved terms in the term bases has to be impeccably applied.

No grammar and punctuation errors are accepted. Please make sure the content has none of these basic issues.

Failure to follow these might result in huge problems, so please bring your A game!

FOLLOW THE AMAZON STYLE

Amazon is expecting a natural, dynamic text that does not read like a machine translation. So please:
1. Be precise, clear, consistent, and natural, while keeping a fresh style.

2. Rework the source sentence in way that conveys the same meaning, but has a natural, dynamic flow.

3. Pav snecial attention to word order in the taraet to avoid ambiauities in translation.
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4. Avoid stilted, unidiomatic sentences.

5. AVOID 1 to 1 translation: do not simply convey the meaning. The text must read naturally, as if originally written in
your language.

6. Shift your focus from merely terminology and stiff accuracy, to naturalness, and flow of in translation that still conveys
the same meaning.

DO NOT ADAPT/TRANSCREATE/LOCALIZE SOURCE CONTENT

We DO NOT HAVE TO LOCALIZE, ADAPT OR TRANSCREATE the source content to what we think may be applicable to final
users. We just have to FOLLOW THE SOURCE for what it says. This also means you don't need to change time format,
units of measurement, currency names, marketplace names, URLs, variables, email addresses, phone numbers,

etc. Examples:

Source: This change will enter into effect on June 30, 2021, for Amazon.co.uk.
Wrong ES: El cambio entrard en vigor el 30 de junio de 2021 para Amazon.es.
Correct ES: El cambio entrara en vigor el 30 de junio de 2021 para Amazon.co.uk.

Comments: Translation localized the marketplace name "Amazon.co.uk” into "Amazon.es". It is extremely important to
keep marketplace names exactly as they appear in source. Please do not localize them in any context.

Source: The fee is reduced from 15% to 7% on the portion of the sales price over €45/£40.
Wrong DE: Die Gebuhr wird auf den Anteil des Verkaufspreises iber 45 EUR von 15 % auf 7 % gesenkt.
Correct DE: Die Gebuhr wird auf den Anteil des Verkaufspreises tber 45 €/40 £ von 15 % auf 7 % gesenkt.

Comments: Translation here omitted the price in pound

Source: As a reminder, FBA inventory was due on December 3 for the holiday season. Please consider sending your
replenishment inventory in January as we focus on fulfilling customer orders during the holiday shopping period.

Wrong CN: 45ittiERE: WEMIRETSE 12 A 3 BELEERFNERE. BFEIRETRA BRI IEE N IET,
E RN ZXERRTIE), FIEEDLAMMEAEEIZRANT R, TR AL,

Correct CN: BANIAREEEE12B3A 2RI HRAZFHERNM L. WTRENME, BREFFIPF—ABREA)z
®, EAEEWYIREEEHRE), ?idl]Eéﬁju\ﬂf_l‘%fi*ﬂﬁﬂifé_@ﬂ’ﬂﬂﬁ, FoHERER H&Hﬁi’m

Comments: Overtranslation of the original concept of "holiday season" into "Christmas". This generated a huge issue
as Christmas is a religious festivity that is not celebrated/applicable in many countries, while the concept of "holiday
season" is neutral and internationally valid

This is mainly because:

¢ Amazon use an authoring tool that creates conditioned text. This means that the text contains variables and/or

alternatives for the same source concent that will automaticallv show to the final reader accordina to snecified rules. So
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for the German example in "The fee is reduced from 15% to 7% on the portion of the sales price over €45/£40 h
condition would make that German readers in Euro countries will read "The fee is reduced from 15% to 7% on the
portion of the sales price over €45" and German users in UK would read "The fee is reduced from 15% to 7% on the
portion of the sales price over £40."

¢ CCM content is not specifically addressed to buyers/sellers/users who live in their native country but worldwide. For
example, the texts we translate in Japanese are not addressed only to native speakers living in Japan, but also to
Japanese people living/doing business from other countries

So this is quite straightforward: do not worry about adapting_specific things like these into the market, just follow the source!

CONTENT TYPES

Seller Central HELP PAGES

Help pages are meant to assist sellers to use Seller Central and understand Amazon Seller business. They include descriptions
of the feature, step-by-step instructions, guidelines, policies, agreements and FAQ. Help content needs to be well-structured,
clear, accurate and easy to understand.

They are in XML-based DITA (Darwin Information Data Format) format.

DITA coding and "country" tells you the marketplace to which the following sentence belong. See more in the TAG section
below.

Example of Help content

Seller Central Ul STRINGS

Strings used for features in Seller Central. Seller Central shows a string as a description text, a title of button, menu item,
option in a dropdown, etc. A string can have variables as well as fixed characters. When placeholders are inserted in a string,

Seller Central allocates text or number to them at runtime. Raise a query in case you need help to understand the

nlaceholders.
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These files may contain lots of tags, so please make sure to run QA checks and DO NOT IGNORE the ones related to:
¢ Tag and formatting errors
¢ Inconsistent Tag Content

Create a prumotion:CF:rlee Shipping

Review c:[ Button titke

Step 1: Conditions

Buyes purchases

Furchases lems

Qualifying Shipging Optians - ©

Example of Ul string content

Brand Registry

For some translation requests, you will be required to work on files with an LOB of CCM-BR. CCM-BR are Brand Registry files
(see CCM OVERVIEW section)

For all Brand Registry (CCM-BR) files, please :

1. DO NOT TRANSLATE the following Program Names, as they should remain as-is:
¢ Brand Registry
¢ Project Zero
¢ |P Accelerator
¢ Transparency

2. Moreover, please do not translate any values within brackes {}, for example: {{Marketplace_Name}}, {{Salutations}}, etc.

SELLER NEWS (SN)

Previously called "Seller Announcements" (SA).

This is a notice displayed in the "News" section of the Seller Central Top page.
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MASS MAILS

Mass emails (MM) sent to limited (or all) sellers in bulk.

PLACEHOLDERS AND CODE are sometimes located in the body text and SHOULD BE LEFT IN ENGLISH:

o SXXXXS$, SIXXXX], {XXXX}, etc.
e <xsl:value-of select="name"/>

BLURBS in AJUDA

Email template that Seller Support Associates use to communicate with sellers. Ajuda is the tool used to create this kind of
blurbs at Amazon.

BLURB NAMES SHOULD BE LEFT IN ENGLISH. Do not translate blurb names, regardless whether they are separated by
underscores or not. You can easily identify these strings because they are included in the first segment of each file, and they
are always in bold format in the Preview tab.

ALWAYS FOLLOW THE DO NOT TRANSLATE TERMS PROVIDED IN THE DNT SPECIFIC LIST HERE WHEN WORKING ON
BLURBS. You will be able to find an automated Xbench checklist with these DNT terms HERE called “Paragon DNT

Iiit".

PARAGON WORKFLOW FOR ASSOCIATES (P4A) Ul STRINGS + BLURBS

"Paragon workflow for Associates" (P4A or Paramount) is an Amazon internal tool that is used by Seller Support Associates to
solve contacts from sellers (people and companies listing products in Amazon).

You can also check some screenshots and mock-ups of the Paragon workflow in this visual guide.

ALWAYS FOLLOW THE DO NOT TRANSLATE TERMS PROVIDED IN THE DNT SPECIFIC LIST HERE WHEN WORKING ON
PAA CONTENT. AS WELL AS ON BLURRBS. You will be able to find an automated Xbench checklist with these DNT
https://digitaltechedge.sharepoint.com/sites/C821AmazonSPCM2/SitePages/Linguistic-instructions.aspx?Mode=Edit#seller-central-help-pages 6/21
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terms HERE called "Paragon DNT list". Running this list is mandatory for Paragon projects.

For CN and KO linguists: Due to client preferences, please use the “Paragon DNT list" found in the checklist folder for
your particular language (CN or KO).

Standard instructions for P4A

« Do not translate acronyms.

« Do not translate blurb names.

« Do not translate any text inside curly brackets (double or single): {{example}} or {example}.

« Do not translate names of internal tools, for eg. "FNSKU Lookup".

« No need to localize URLs.

« Please always translate words between double, triple, and single asterisks **example**,

***example***, *example*.

» [please translate] content inside the square brackets. If the content in square brackets is too hard to translate, e.g. Amazon
jargon like “Trouble Ticket”, you may leave them in English as these will be replaced with translated text by associates anyway
before sending out the communication. Raise a query for doubts.

« Any seller-facing content which might be quoted in associate-facing content is subject to “Paragon for Sellers” (P4S)
instructions. These are easily identified by instructions to associates such as “Copy the following text to send to the selling
partner:”, where the text that follows would be seller-facing.

How to process tags

+ Itis acceptable to change the position of tag(s) in translation when necessary. Example: "<tag1> View case ID <tag2>" ="
<tag1> Fallnummer <tag2> anzeigen"

« Please keep the punctuation between tags the same position as in source. The punctuation itself may be changed to
match the target language, but the position remains the same.

« Multiple tags should be considered as “one” word and treated as singular. Example: "FNSKU [tag1][tag2],[tag3] will not be
eligible" = "Le FNSKU [tag1][tag2],[tag3] en bénéficiera”

Special syntaxes

If any of the below syntaxes is changed or any additional space is added, the workflow will break as it will not be able to
render the page.

{{DO NOT TRANSLATE}}

<a href="DO NOT TRANSLATE" >TRANSLATE</a>
<br>

<DO NOT TRANSLATE>

Please make sure to run QA checks and DO NOT IGNORE tags related to:
¢ Tag and formatting errors
¢ Inconsistent Tag Content
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PARAGON WORKFLOW FOR SELLERS (P4S) Ul STRINGS + BLURBS

“Paragon workflow for Sellers" (P4S) is an Amazon internal tool that is used by operators in call centers to automate steps
and provide solutions to sellers.

You can also check some screenshots and mock-ups of the Paragon workflow in this visual guide.

ALWAYS FOLLOW THE DO NOT TRANSLATE TERMS PROVIDED IN THE DNT SPECIFIC LIST HERE WHEN WORKING ON
P4S CONTENT, AS WELL AS ON BLURBS. You will be able to find an automated Xbench checklist with these DNT
terms HERE called "Paragon DNT list". Running this list is mandatory for Paragon projects.

For CN and KO linguists: Due to client preferences, please use the “Paragon DNT list" found in the checklist folder for
your particular language (CN or KO).

Standard instructions for P4S

« Do not translate blurb names.

« Do not translate any text inside curly brackets (double or single): {{example}} or {example}.
* No need to localize URLs.

« Please always translate words between double, triple, and single asterisks **example**,
***example***, *example*.

« [please translate] content inside the square brackets.

How to process tags

« Itis acceptable to change the position of tag(s) in translation when necessary. Example: "<tag1> View case ID <tag2>" ="
<tag1> Fallnummer <tag2> anzeigen"

+ Please keep the punctuation between tags the same position as in source. The punctuation itself may be changed to
match the target language, but the position remains the same.

« Multiple tags should be considered as “one” word and treated as singular. Example: "FNSKU [tag1][tag2],[tag3] will not be
eligible" = "Le FNSKU [tag1][tag2],[tag3] en bénéficiera”

Special syntaxes

If any of the below syntaxes is changed or any additional space is added, the workflow will break as it will not be able to
render the page.

{{DO NOT TRANSLATE}
<a href="DO NOT TRANSLATE" >TRANSLATF</a>
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<br>

<DO NOT TRANSLATE>

Please make sure to run QA checks and DO NOT IGNORE tags related to:
¢ Tag and formatting errors
¢ Inconsistent Tag Content

QUi emery Picog Ocws Adactiog St Repors Padomince Appstore 828 ST NN - |1 (T )

Help for Amazon Sellers
Mo Listing Eror ==

Manage Inventory

Need more helpy T

Account settings

Manage orders

Payments

Example of P4S content (the right hand of the workspace)

AD-HOC REFERENCES WITHIN ATMS

Sometimes Amazon PMs can include specific screenshots, glossaries or reference material for your reference within the ATMS
for that specific task/file. So please make sure to always check the References tab to see if any downloadable file available. If
yes, please download these additional references and refer to them during the translation. For example:

MT STRINGS AND HIGH FUZZY MATCHES

¢ Machine Translation should be reviewed and extensively edited. Avoid literal or unnatural translations as final output is
expected to have HUMAN QUALITY (should sound as if it were written in your own language by a native speaker).

¢ 100% and High fuzzy matches should be checked and reviewed. Do not trust them blindly. Terminology might have
changed, translation in legacy is not necessarily correct, so do not automatically trust them and make sure

to review and apply changes as needed.

CCM STYLE GUIDES
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Please find HERE the specific CCM style guides with detailed instructions for each language. Make sure to read it and
carefully refer to it for each task

It contains not only style indications, but also grammar conventions and Localization preferences (standard sentences, to-be-
avoided terms and structures, etc.).

Also, style changes according to the text type (Ul, Help, Blurbs, etc. so it is extremely important you check this every time
specifically). Raise a query to us in case of doubt.

LINE OF BUSINESS AND PIPELINE

¢ Pipeline: The Pipeline determines whether the project belongs to Country Launch or Daily Projects.
o Languages in Country Launch are new to Amazon, the content for which has not been published online yet, and
are being prepared for launch.
o Languages in Daily Projects have already been published, and the new content being translated will be
published alongside the content that has been launched.
¢ Line of Business (LOB): The Line Of Business refers to whether the project belongs to Seller Central (SC), Brand
Registry (BR), or Vendor Central (VC). For more information on these, check the information at the top of this page.

HOW TO DETERMINE THE LOB AND THE PIPELINE

¢ To determine the Pipeline, check Client and Note under the Project info pane in the in the project screen in ATMS. If
it says "CountryLaunch” or “"COUNTRY LAUNCH", the project belongs to the Country Launch pipeline.
¢ To determine the LOB, you must check the name of the project in the in the project screen in ATMS.
o SC: Seller Central
o VC: Vendor Central
o BR: Brand Registry

For instance, the LOB of a project with the name “Chopin_SC_Paragon WF_P4A True_SEDIT-205118-pl_PL-AST-
Ixiaya” is “SC", which means this belongs to “Seller Central”.

NOTE: Contact Pactera if you can’t see this clearly. Please note that, sometimes, there might be full name of the
LOB in the title as well.
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PRIORITY FOR TERMINOLOGY REFERENCE AND TMs
DAILY PROJECTS

PRIORITY 1: Glossary with approved terminology and Knowledge Base, both integrated within ATMS.
e NOTE: If more than 1 TD is added to the project by the PM:
e TB* = Primary TB
e TB** = Secondary TB
J : GOLDEN TM, the most reliable TM with strings approved by the customer. However, sometimes TB
and style guide are updated without implementing necessary fixes in the legacy content in this TM. So it can happen
that some strings here are not fully comply with TB and latest style guide version. In those cases we need to fix

translation accordingly.

Special note for FR, IT and ES-MX: not all the translations from the Golden TM were fully reviewed by the client.
Please re-use translations from the Golden TM with extra care and make any changes that may be required
(especially for consistency with the glossary).

e PRIORITY 3: UNREVIEWED/SILVER TM, which contains unreviewed and less reliable strings

In case of inconsistencies, please refer to the above priorities in order to choose the best option. Raise a query to us in case
of doubt.

NOTE: The term ‘Seller Support’ is being replaced by ‘Selling Partner Support’ since now it applies not only to sellers,
but also to vendors, and to brand owners. Amazon is keeping_the deprecated source term in our TB to prevent the wrong
term being_used in translations in cases where the source editor forgets to use the right term. This is applicable to all

languages now.

COUNTRY LAUNCH

As with Daily Projects (see above), the terminology reference with the highest priority is the Glossary, followed by the Golden
TM, and followed by the Unreviewed or Silver TMs.

However, if there are more than one term base, the priority of each for Country Launch is determined by the Line of
Business (LOB) in which you are working. This means that you must determine the LOB of the task, then pay close attention
to the Term Bases used for the project, and prioritize the ones specific for that LOB.

NOTE: To properly assess the LOB, please check the section "LINE OF BUSINESS AND PIPELINE" above.

Once you determine the LOB, you can assess which Term Base you should pay the most attention to.

¢ For Seller Central projects, the SeCm SOAFBA TD term base is the one with highest priority, over all other TBs.
e For VC projects, the Vendor Central TB is the one with highest priority.
¢ For Brand Registry projects, the Customer and Brand Protection is the one with highest priority.
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You can see the name of the Term Base to which the term belongs to in the CAT or Search tabs, on the rightmost pane.

If you see several of the same terms, click on them to see their information and select the one belonging to the highest
priority Term Base.

KNOWLEDGE BASE

The Knowledge Base (KB) is a term base that is based on scorecards’ defects (such as General Style, Incorrect
Translation/Meaning, Glossary and Context, among others) and Amazon knowledge. The purpose of this TB is reducing the
number of errors that are found in monthly QAs and it contains stylistic preferences and guidelines provided by the Amazon
editors.

For now, it is only configured for German, Japanese, Spanish, Mexican, and Turkish languages.

It is important to remind that KB entries are country specific.

Example of KB entry:
In Amazon content for Spanish, “antes del X DATE" (before X DATE) is historically considered an incorrect translation of “by X
DATE" (for example, “You must create a removal order by February 10 or Amazon may close your account.”). In those cases, a

valid translation would be “a mas tardar el X DATE" (no later than X DATE).

In ATMS, it will be shown like this:
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Ul OPTIONS

Please check HERE the Ul options for your language. This is not available in ATMS, so you will need to check them offline
(using Xbench for example).

This will be updated on a biweekly/monthly basis depending on the language.

If you cannot find the corresponding Ul option here, please raise a query. DO NOT INVENT the Ul options as this is a Major
error for the customer in LQAs.

For languages that do not have the Ul extract, please use the testing accounts to look for them in the live environment.

TESTING ACCOUNTS

Testing accounts to access the Seller Central platform and search/see the strings in context or look for cross-references (help
page titles, etc.) are NOW AVAILABLE. Click HERE to open instructions.

These accounts should be used also to look for Missing Ul options that are not available in the Ul options extract (if any).

HOW TO HANDLE CONTENT INSIDE SQUARE BRACKETS

As a general rule, the content surrounded by square brackets ([ ]) should be handled differently depending on whether it
belongs to the PARAGON content type or not (for more information on PARAGON/NON-PARAGON content types, see the
section CONTENT TYPES).

NOTE: Please check the Style Guide for your language carefully to see if it contains specific instructions on how to deal with
this content. If so, please give first priority to the instructions in the Style Guide. Otherwise, please follow the rules below:

NON-PARAGON CONTENT TYPES

Please handle the content inside square brackets depending on the following cases:

1. Content all in UPPER CASE between sauare brackets is NOT localizable. Some exambles:
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e |ts next destination is [NEXT_DESTINATION].

¢ Seller Central String Build Sanity Check [DO NOT MODIFY]

e Shipment [SHIPMENT_ID] contained an overweight package weighing [WEIGHT] pounds that did not have a
Team Lift or Mech Lift warning on the package.

2. CamelCase content between square brackets is NOT localizable. Some examples:
e Fulfiller ID in message [partyldinMessage] does not match the one on order [orderld]
e COD fulfillment order [CustomerOrderld] must have a feed Id
e You are ahead of [sellerPercentile]% of sellers similar to you.

3. Other content between square brackets may be localizable or not. Some examples:

e Buy Box price raised to [value] ====> unlocalizable

¢ Add listings to "[rule name]" ====> unlocalizable

e English Name [blank] Chinese Name ====> unlocalizable
e Quantity Reimbursed [Inventory] ====> localizable

¢ [Email Address] is missing. ====> localizable

e Your VAT ID [optional at this time] ====> localizable

NOTE: We know that point 3 is still confusing. For content of this type, we recommend you to raise a query if you
have any doubts so that we can escalate it to the customer.

PARAGON CONTENT TYPE

1. For the Paragon content type, all content inside square brackets should be translated. Note that ALL BLURBS
should be considered as part of Paragon, so content inside square brackets should be translated for ALL BLURBS.

For more information on the Paragon content type and this rule, please check the Paragon sections below, under
CONTENT TYPES.

QUOTATION MARKS FOR Ul STRINGS

When translating/reviewing Ul strings, please make sure that the quotation marks surrounding the text are identical to the
source.

This means that, if you see that the source in Ul strings uses double-byte quotation marks, you should use the exact same
quote marks in the target. For instance:
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Please note that the original source uses double-byte quotation marks (*) while the incorrect target uses single-byte
quotation (™).

For Ul strings, please use the exact same quotation marks as in the source. To check this, you can use the TAGGING
CHECKLISTS available to you in this SharePoint (you can find instructions on how to run these checklists in the XBENCH
CHECKLISTS section below).

For regular non-Ul strings, please follow the normative instructions for your language as explained in the APOSTROPHES /
QUOTES section in this SharePoint.

HELP PAGE TITLES

Please find HERE some tips and instructions on how to retrieve the correct titles for Help Pages. This has been detected as
a frequent error in the Full MTPE LQA scores we received from the customer and it is a very useful asset to guarantee
accuracy in Full MTPE deliveries (on the contrary, this check should not be done for Light PE tasks as this is one of the things
that should not be fixed for Light PE scopes). Make sure to check it and install the related add-in in Chrome.

TAGS

Make sure you go to Edit > Tags > Expand tags to show the DITA elements and their attribute values.
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This is to make sure you know the meaning of the tag and you get some info about the context. In the sample below, the
DITA tag tells us the sentence "Whether you adopt this or any other pricing rule is optional and you can turn it off at any time
for any ASIN you choose.” is written for UAE, Australia, Canada, China, Germany, Spain, France, United Kingdom, Italy, Mexico
and United States marketplaces. While the sentence in string 13 will only appear in Japan marketplace.

Another example for Chinese: "m4EkAY" will only display on the live page for EU mps, and the words without condition tags
"ERXT" will display on live page for ALL mps. Therefore any unneeded contents (characters or spaces) left outside of the
country condition tags could cause extra spaces or other unexpected errors. So please ensure to set your ATMS to “Expand
Tags” to understand the purpose of the tags, and handle such conditioned contents carefully.

Also, the customer has changed the way tags are shown and managed withing ATMS files. Please check the specific Regex
Tagging Logic instructions here.

SPACES BETWEEN TAGS

To avoid severe page breaks and coding issues, please make sure to keep the spaces between the tags as they appear in
the source.

In the examples below, the tags have incorrect spaces between them. They should follow the source exactly to avoid breaks.
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To help you see this more clearly, make sure to always activate the Display hidden characters option (the ﬂ button) in the
upper tool ribbon.
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CONDITIONALIZATION AND CONDITION TAGS

Strings may include parts that are shown only for specific marketplaces

¢ Conditionalized parts of segments are surrounded by tags with country code(s) and only shown on those marketplace
sites.

» Conditions can be used within a sentence, for example, to account for different currencies (like $ and €), but they can
also be used at the paragraph level if entire sentences need to be written differently for different marketplaces.

¢ These conditionalized parts replace one another on the final website: content tagged “country= SE” for instance will
only be shown on the Swedish marketplace site, any other country-tagged parts will not display.

¢ Since these tags are conditionalized for different countries, they cannot be left empty. If so, it would result in this text
missing from the text for the respective country. For example:

Conditionalization makes sure that for the relevant marketplaces the correct links are shown
To see the conditions, click Ctrl+Shift+E to expand the tags or go to click Edit > Tags > Expand Tags.

You have to make sure those conditionalized phrases fit the parts that are not conditionalized (i.e. shown for all marketplaces)
and into the overall grammatical structure of the segment. For example:

Source: By enrolling, you agree to the {1>terms and conditions and program requirements<1} {2>terms and conditions and
program requirements<2}.
Wrong translation: Durch die Registrierung stimmen Sie den {1>Teilnahmebedingungen und den

Proarammanforderunaen<1} zu. {2 >Teilnahmebhedinaunaen und den Proarammanforderunaen<?2} zu.
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Correct translation: Durch die Registrierung stimmen Sie den {1>Teilnahmebedingungen und den
Programmanforderungen<1} {2>Teilnahmebedingungen und Programmanforderungen<1} zu.

Example of a correct translation:

APOSTROPHES / QUOTES

Some languages (like Italian, French, Turkish, etc.) use special apostrophes/quotes. For example, French uses curly
apostrophes and chevrons. [talian and Turkish should have straight apostrophes and quotes. This configuration should be
set in Format > Quotation > Target and selecting the correct option. This should be set just once and ATMS will keep it for
the following logins. See the example below for Italian:

TRANSLATION TOOL & ATMS QA CHECKS

For this project we are going to use ONLY the ATMS Web editor. QA checks are mandatory and integrated within ATMS.
Check the technical instructions for translators and reviewers (there are useful tips and tricks) and also refer to specific QA

section HERE.
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For Asian languages (KO, JA and CN), please make sure to extract the files from ATMS and run linguistic checks (spelling,
grammar, etc.) offline, for example in Word or in Xbench. This is because ATMS integrated linguistic checks for Asian
languages do not work properly.

Before the delivery, it is MANDATORY:

¢ To run the QA checks across all the files opening them all together in the same view for consistency issues (and
not on each file separately). You can select all the files at once from the Jobs view and click on one of them to see the
merged view.

e Fix all the real issues and mark the False Positive as FP. You can select multiple error rows by holding CTRL. You can
also order the errors by Issue type by clicking on the Type column heading.

¢ Make sure you have checked all the issues by scrolling down to the very bottom of the list. Sometimes, when there is a
high number of issues, some of them are hidden and a "More..." button will be displayed. Make sure to check them
all.

¢ Make sure you have a green tick under the QA column before marking the file as Delivered. This means you have done
QA checks properly. Otherwise, you will see 3 dots or other error symbols in case you still have some issues to fix or to
mark as FP.

# Progress QA Fila
1 100% M © TRMS_7730_DE.docx

2 100% \f (@] TRMS_7730_ES.docx

XBENCH CHECKLISTS

Before delivering a file, make sure to run the specific language Xbench checklists, as well as the general Tagging/Bracket
handling _checklist for ALL LANGUAGES. They will help you avoid known and common issues that have been described in
the style guide or in customer feedbacks.

Language-specific checklist:

These are checklists which were created based on specific linguistic feedback from the client. These will solve some of the
commonly-

found issues. Please take the checklist specific for your language.

General Tagging/Bracket checklist:

These are checklists specifically created to detect possible tagging issues in the files (spaces between tag components,
translatable or untranslatable bracketed content, etc.)
e NOTE: there are two checklists. You must use the correct one depending on the content type:
o PARAGON_&_BLURBS_Amazon_CCM_Brackets_& _Blurb_titles_v2.8: Use for Paragon and Blurb content.
o NON-PARAGON _AMAZON _CCM_PLACEHOLDERS v2.3: Please use for all other content.

Please check the CONTENT TYPES section above for more information on content types. | you have questions related to
content tvne. nlease contact the nroiect manaaer who assianed vou the task.
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PROCESS

Please make sure that before delivering the project you:
¢ Download the bilingual files in mxliff format (select the files from the project screen > Download > Bilingual MXLIFF)
o NOTE: if you're using Xbench 2.9, please download the bilingual files in TMX format. Memsource-based MXLIFF
files are not supported in 2.9.

¢ Load the bilingual files in Xbench (F2 > drag and drop the bilingual file > OK > OK)

¢ Load the specific checklist for your language (Checklist manager icon > right button in the Personal Checklists
column > Add > select the checklist > Open)

e Go to QA tab, select Checklists and double-check that your checklist is shown under List of Checks and selected.

e Exclude ICE segments that are always out of our scope and click Check Ongoing Translation

¢ The tool will run the selected checks and show you a report of results. Fix the real issues in ATMS and ignore the false
positive hits.

You can also watch our video training about this here in the Trainings section.

IMPORTANT NOTES:

1. If there is no language-specific checklist available for your language, do download and run the general tagging
checklist.

2. Xbench can be used also to do other checks (like inconsistencies in source, target, numbers, tags, etc.) or make
searches within TMs, TB, bilingual files, etc. If you don't have it, you can download it HERE (2.9 version is freeware).

3. You can find some detailed instructions on how to run and create your own checklists and make advanced searches
HERE

4. For other general training and instructions on how to use this tool, please check the official Apsic Xbench
Documentation and YouTube channel.

QUERY MANAGEMENT

In case of linguistic doubts, please raise a query using our query management system GLOBAL QUERY (C821-Amazon CCM
project).

You can find instructions on how to use it HERE.

Do not make assumptions! Raise a question and make sure to double-check all your doubts before the final delivery to the
customer.

Note: make sure to leave the queries with the Private status (default selection). DO NOT change it to Public.

SELLER CENTRAL TUTORIAL VIDEOS

You can find here some video tutorials which describe some important Seller Central features.
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¢ Quick start guide: Intro to Seller Central
e Quick start guide: Account Info

¢ Manage inventory

¢ Adding Products

e Manager Order

¢ Fulfillment by Amazon

e FBA: Your first FBA Shipment: Part 1

e FBA: Your first FBA Shipment: Part 2

¢ Quick start: Intro to Seller Fulfilled Shipping
e Payments

o Seller Performance
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